
Rick and Tim’s 
Thirty Dirty Tricks for Acrobat 8 

PREFERENCES 

1) Copy Encircled Text into Sticky Notes 

If you frequently use sticky notes to indicate major re-writes to text, this tip may save you some time. Select some text to highlight 
and it appears in your note—ready to edit! 

1. Edit Preferences  

2. Choose  the Commenting category 

 

2) Increase the Number of Recently Opened Documents 

Doh! Can’t find that document you opened earlier in the day?  Use this to keep track of more frequently accessed documents in 
the File menu. 

1. Edit Preferences  

2. Choose the Documents category 

 

3) Get Fast Access to Tools with Single Key Accelerators 

Single key accelerators let you quickly get to tools by typing a single keystroke such as Z for the Zoom Tool or H for the Hand Tool. 
Oddly, these are on by default in other Adobe applications, but not in Acrobat. 

1. Edit  Preferences 

3. Choose the General Category 

 

4) More Efficient TIFF to PDF Conversion 

By default, Acrobat does not change the compression on older, less compressed TIFFs when converted to Acrobat. We can do 
better and make smaller PDFs from TIFF files by changing a Preference. 

1. Edit Preferences 

4. Choose the Convert to PDF category 
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5. Choose TIFF from the Converting to PDF list 

 

6. Click the Edit Settings button 

7. Change the setting for Monochrome to either JBIG Lossless or JBIG Lossy 
 

    

8. Click OK 
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PDF CREATION 

5) Better PowerPoint Conversion 

If you’re PowerPoint files contain a lot of images and you are mostly concerned about high-quality onscreen viewing—rather than 
printing—try this tip to create better looking, smaller PDFs from PowerPoint. Let’s a create a new PDF Job Options setting to 
change the way that images  in presentations are processed to PDF. Once you create the new setting, it will be used for 
conversions in PowerPoint. 

1. Inside PowerPoint, choose AdobePDF Change Conversion Settings 

2. Click the Advanced Settings button 

3. Select the Images category from the left and set as follows: 

 

4. Click the Save As button and name. e.g. Powerpoint.joboptions 

6) Create PDF from Blank Page 

Although Acrobat is great at working with PDFs, it wasn’t until Acrobat 8 that you could create new, original PDFs! This feature is 
great for creating cover pages for packages, blank pages, separator pages and so on. 

Choose File Create PDF From Blank Page 

Insert your cursor and start typing! Use the toolbar to change font, size, color, indent, etc: 

 

 

Change Page Setup
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7) Showing and Creating a Presentation (complete with Speaker Notes) 

You can actually use Acrobat to present slides full-screen by choosing View Full Screen Mode. Hit the ESC cape to go back to 
normal view. Using Acrobat 8’s enhanced PDFMaker for PowerPoint, you can add your speaker notes as a layer in your PDF. 

1. Open your presentation in PowerPoint/ 

2. Use your PDF Maker button in PowerPoint/ 

3. If you have speaker notes, you will see a dialogue box pop up and ask you if you would like to add your notes. 

8) 2D DWG to PDF 

So, you need to get that AutoCAD drawing into a PDF but you don’t have AutoCAD?  No problem, with Acrobat 8 Professional it is 
a simple drag and drop.  You get all the paper space and model space data, into a combined PDF! 

1. Open Acrobat 8 Professional 

2. Select your DWG file 

3. Drag and Drop it into Acrobat 

Here is a view of the finished PDF: 

 

 

See Tim’s article Creating PDF’s with out AutoCAD for more details. 
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9) 3D DWG to PDF 

Oh excuse me, did you need to get that 3D AutoCAD drawing into a PDF but you don’t have AutoCAD? No problem, with Acrobat 
8 3D it is a simple drag and drop.  Again, you get all the paper space and model space data, into a combined PDF!  Supporting 
AutoCAD 14 -2007 

1. Open Acrobat 8 3D 

2. Select your DWG file 

3. Drag and Drop it into Acrobat 

Here is a view of the finished PDF: 

 

 

See Tim’s article Creating PDF’s with out AutoCAD for more details. 
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10) Choose Sheets from Excel/Fit to Page 

Don’t want all of the worksheets in an Excel file to convert to PDF? No problem! Acrobat 8 offers you more control than previous 
versions. 

1. In Excel, choose AdobePDF Change Conversion Settings 

2. Ensure that “Prompt for selecting Excel sheets” is enabled 

3. Click OK 

4. Choose AdobePDF Convert to Adobe PDF 

 

SEARCH 

11) Search PDF's across a directory 

This is a great little tip allowing you to find information embedded in PDF files across a directory structure. 

1. Open Acrobat 8 

2. Edit Search 

3. In the Text Box type in the word(s) you are searching for. In this case, I am looking for documents that contain the word 
PDF somewhere in them 

4. Select the Radio Button “ All PDF Documents in:” 

5. Select the pull down, then navigate to the directory you want, here I am looking in My Documents directory, it will also 
crawl through all the sub-directories  

6. Hit Search Button 
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Here is a before/after picture: 

 

Settings for the search Search Results 

  
 

12) Index a directory for faster searches 

Wow, so searching across directories is cool, but, it could take some time, the best thing you can do that to speed up your 
searches is to create an index across those directories! 

1. Advanced Document Processing Full Text Index with Catalog 

2. When you get this dialogue box select new index 

 

3. From here you can set the directory and all the info you want to index 
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4. This will create an index file on the hard drive in this case the index file is “Documents.PDX”, this is used in the search 
dialogue box. 

 

13) Embed a search index in a document (Acrobat Pro only) 

If you work with PDFs with lots of pages—over fifty—this tip can make searching much faster! 

1. Advanced Document Processing Manage Embedded Index 

2. Acrobat will embed a search index 

 

3. To search the entire PDF, choose Edit Search 

14) Embed a search index in a package 

A PDF Package can contain a great many individual documents. Search across them quickly by embedding a full-text index. The 
index is contained in the Cover Sheet of the PDF. 

1. Click the Cover Sheet button in the upper left corner of the Package window: 
 

 

2. Advanced Document Processing Manage Embedded Index 

3. Click the Embed Index button. 
 

To search the entire PDF Package, choose Edit Search and then choose the option to search Entire PDF Package. 
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BATCH FILES 

15) Batch Logging 

If you use Batch Processing, you may occasionally run into errors during the way. Acrobat can create a log file of any errors which 
can help you to diagnose problems. 

1. Edit Preferences 

4. Choose the Batch Processing category 

5. Enable the checkbox for Save warning and errors in log file and choose a location for the error log 
 

 

16) Batch, Print Only Watermarks 

Have a lot of PDFs to watermark? Use batch processing to quickly add watermarks to lots of files. Did you know that you can set a 
watermark to only show when printing? That’s useful feature for ISO9001 companies which need to mark documents when they 
are uncontrolled. 

1. Advanced Document Processing Batch Processing 

2. Click the New button and give the sequence a name  

3. From the list on the left, choose Add Watermark 

 

4. Double-click Add Watermark from the list on the right 
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5. Format your watermark text as desired. Click on the Appearance Options link and disable Show when displaying on screen. 

 
 

17) Batch DWG to PDF (Note this is windows only and Acrobat 8 Professional or above) 

Batch DWG has to be done from within AutoCAD (up to 2007), it is very straight forward and here’s how you do it 

1. Open AutoCAD  

2. Adobe PDF Batch Conversion 

 

3. In this dialogue you can select if you want a single PDF for each drawing (multi Sheet DWGs into multi sheet PDF), if you 
want layers, you select if you want to include Model Space or just Layouts, and you can save the list. 
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ANNOTATIONS AND COMMENTS 

18) Changing text in a textbox (a better Typewriter tool) 

I was at a customer site one day and the question came up, how do you change the text style in the Text Box?  Well I was thinking 
that all I needed to do was Right Mouse Click and that only allowed for Bolding and such but they wanted to change the font type 
so I had to do some digging here is what I found: 

4.  View Toolbars Comment & Markup Text Box Tool 

 

5. Add a text box on to the PDF 

6. Now select the text and hit a Ctrl-E 

7. Now change the font type and other changes needed 

 

See Tim’s article changing the font in a Text Box for more details. 

19) Snapshot Tool for Stamps 

Stamps are one of the most useful items in Acrobat.  The SnapShot tool allows you to take a graphic from one PDF and use it as a 
stamp for other details.  A good example is CAD details here we will take a door detail and use it for mark-ups. 

1.  Tool Select & Zoom Camera Tool 

 

2. Take a Snap Shot of the area you want to use as the stamp (this places  the data on the Clip Board) 

3. Go to File Create PDF From Clip Board (this creates a PDF of the snap shot) 

4. Save the PDF file 

5. You now need to add a custom stamp Tools Comment & Markup Stamps Create a Custom Stamp 

6. Browse and select your snap shot 

7. Select next and put your new stamp in an existing group or create a new one, and also give the stamp a name 

8. Your stamps now show up in the list 
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20) Creating Custom Dynamic Stamps 

Be careful when creating your new whoopee wow stamp. Don’t go and scan in your stamp and use a 2 Mb file.  When you start 
applying this monster, you will be adding 2 Mb each time!  Use a graphic program such as Photoshop or Illustrator.  I personally 
use Illustrator because it creates vector graphics, and it will save and work natively as PDF. Vector files also scale beautifully when 
you size your stamp.   
  

1. Select the Stamp Tool button and go down to and select Create Custom Stamp… you will see the Select Image for 
Custom Stamp dialogue box shown below 

  

2. Now select Browse and select your stamp 
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3. Once up see your stamp in the preview window, click OK.  You will see the dialogue box shown below. If you have never 
created a custom stamp before, create a new category by typing a new name in the category pull down.  Give your new 
stamp a name, and if you used PDF then Uncheck the Down sample stamp to reduce file size. If you used a TIFF or BMP 
file or a native file format, then leave this checked.   

 

4. Click OK  

 

5. Now let’s check your new stamp by inserting it into your file.  When you go to the insert stamps location you will see your 
new category listed and your new fancy stamp listed. 

30 Dirty Tricks for Acrobat 8  Rick Borstein Tip |   Tim Huff Tip All Rights Reserved— 13 of 25 
  Revision 1.0 



 

 Pretty cool huh!  So far it has been straightforward, from here on out this is a procedure that is not supported by Adobe, so 
please if you don’t get what you wanted do not call customer support. 

 Adding the dynamic gizmo to your custom stamps… 

Take this part a bit slowly because it is not 100% straight forward.   

6. Go to your LOCAL Settings and go to this directory.  In my case it is the following: 

C:\Documents and Settings\thuff\Application Data\Adobe\Acrobat\8.0\Stamps 
You will replace thuff with your information.   

7. In that directory there will be one or many (based on how many custom stamps you have) very strangely named files, in 
my case the file name is; NsZpGu5eHSwLlyVa5gRhsC.pdf if you want to change the name do it now!  If you do it later this 
will probably fail! 

8. Now sort by date and open the newest file in Acrobat 8 Professional. 

 

9. Ok good do you have it open?  It’s ok I can wait………Ok now let’s move to another directory that is equally hard to find, 
this will be where the stamps that ship with Acrobat 8 Professional are stored. 

 On a standard Acrobat installation the location will be: 
 C:\Program Files\Adobe\Acrobat 8.0\Acrobat\plug_ins\Annotations\Stamps\ENU 

10.  Double click on Dynamic.PDF to open in Acrobat 8 
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11. Now, make sure you go down a couple of pages in Dynamic.PDF till you see a stamp that has By:foozle at 8:50pm, Aug 
25,2004, the one I choose was the REVIEWED Stamp 

 

12. If you have never used the forms technology in Acrobat, this may get tricky.  In Acrobat 8 Professional and Acrobat 3D 
Version 8,  go to the Tools menu pull down and then select Forms. On the flyout, select Edit Layout . Your stamp should 
look like this below: 

 

13. Select the field, when it turns red, Right Mouse Click and select Copy. 

14. Then switch to your custom stamp and paste, you can move it to the correct location and then scale it up or down by 
dragging the corner areas. 
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15.  Close and save your new custom stamp, do not use Save As, just hit Save.  

16. Now let’s insert our new Dynamic Custom Stamp! 

 

17. And there you go a Dynamic Custom stamp! 

 

See Tim’s article Dynamic Custom Stamps for more details. 
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21) Using the Pencil tool as a highlighter 

The Highlight Text annotation tool is terrific, but it only works on documents with text. You can change the properties of the 
pencil tool so that it can be used as a highlighter on image-only PDFs. 

1.  View Toolbars Comment & Markup 

2. Select the Pencil tool 

 

3. Click and drag to create a pencil annotation 

4. Select the pencil annotation you created 

5. Right-click and choose Properties to set the pencil width, color and opacity (transparency). 

 

6. Click Make Properties Default to save these settings every time you use the pencil tool. 
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WORKING WITH PDFS 

22) Compare Documents (text) 

Acrobat allows you to compare to text-based documents to see if there have been changes. 

1. Advanced Compare Documents 

2. Use the Browse button to locate your older document and newer document. 

3. For text comparison, set up as follows: 

 

4. Click OK. 

See Rick’s article Comparing Two PDFs for more details. 
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23) Reducing File Size with the PDF Optimizer 

If you receive scanned PDFs from outside your organization—or use a device which scans to PDF—often these files will be only 
minimally compressed. For example, most devices will produce a 50K file from a black and white scanned page. We can make 
these PDFs smaller! 

1. Advanced PDF Optimizer 

2. Click Images from the list on the left.  Set as follows: 

 

3. Save the setting when prompted 

24) Place an image in a PDF 

Need to quickly place a picture into a PDF? No problem! 

1. Tools Advanced Editing Touchup Object Tool 

2. Right-click and choose Place Image 

3. Click the Files of type menu at the bottom of the screen to target the kind of file you wish to import: 
 

 

See Rick Borstein’s Blog article How to Import/Place an Image in a PDF for complete instructions.  
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25) Cleaning up Scanned Documents with Redaction Tools 

Redaction is the permanent deletion of sensitive data from documents. While redaction is most often used in the legal context or 
in government, it can also come in handy for cleaning up scanned documents by “whiting out” areas. 

1. View Toolbars Redaction 

2. Select the Mark for Redaction tool 

 

3. Click and drag to mark an area on the page 

4. Right-click while over the Redacted area and choose Properties to set the color to No Color: 

 

5. Click the checkbox Make Properties Default if you wish to always use no-color redactions. 
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26) Compare Documents (drawing) 

Acrobat allows you to compare to graphic-based documents to see if there have been changes. 

1. Advanced Compare Documents 

2. Use the Browse button to locate your older document and newer document. 

3. For text comparison, set up as follows: 

 

4. Click OK. 
 

27) Touchup Object 

Touch up object allows you to add, subtract, or move objects within a PDF 

1. Open your PDF 

2. Tools Advanced Editing Touchup Object Tool 

3. Now simply select objects in the PDF to change 
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WEB 

28) Adding a Print Button to a PDF 

Do you upload PDFs to your website? Naïve visitors to your site may not know that they need to click the Print button on the 
Acrobat toolbar to print a PDF. Make it easier by adding a Print button to a PDF. 

1. View Toolbars Forms 

2. Click the Button tool 

 

3. Click and drag to draw a button on the page. The Button Properties window will open. 

4. Click the Appearance tab to choose borders, fills and styles: 
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5. Click the Options tab and type the button text: 

 

6. Click the Actions tab 

 

7. Selection Action:  Execute a menu item 

8. Click the Add button 
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9. Choose File Print from the list and click OK 

 

10. Click Close 

29) Web Capture a selection 

Most folks know that you can web capture an entire page. Did you know that you can capture part of a web page? 

1. Start Internet Explorer on Windows 

2. Select some text on the page 

3. Right-click and choose Convert Selection to Adobe PDF 

30) Add pages to web captured file 

A web captured PDF isn’t static. Links are live and additional pages can easily be appended to a document. 

1. Web Capture a PDF within Internet Explorer on Windows or using Acrobat 

2. Right-click on a link and choose Append to Document 
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BONUS TIP 31: Converting an RSS Feed to PDF 

Did you know that Acrobat can directly open and convert an RSS feed to PDF? You can use Acrobat as a News Reader!  

1. Go to the website or blog which you want to capture and find the RSS XML feed 
Generally, the feed will have an RSS icon: 

 

2. Click on the RSS icon to get to the feed URL. Copy the feed URL to the clipboard. 

3. Comments Review Tracker 

4. Click the RSS button in the Review Tracker window 

 

5. Click the Subscribe button 

 

6. Enter the RSS feed URL into the subscribe window. 
(It will likely be pasted in automatically) 

7. View the RSS feed inside the Tracker window: 
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